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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Introduction
The LatticeECP3™ (EConomy Plus Third generation) family of FPGA devices is optimized to deliver high perfor-
mance features such as an enhanced DSP architecture, high speed SERDES and high speed source synchronous 
interfaces in an economical FPGA fabric. This combination is achieved through advances in device architecture 
and the use of 65 nm technology making the devices suitable for high-volume, high-speed, low-cost applications.

The LatticeECP3 device family expands look-up-table (LUT) capacity to 149K logic elements and supports up to 
586 user I/Os. The LatticeECP3 device family also offers up to 320 18 x 18 multipliers and a wide range of parallel 
I/O standards.

The LatticeECP3 FPGA fabric is optimized with high performance and low cost in mind. The LatticeECP3 devices 
utilize reconfigurable SRAM logic technology and provide popular building blocks such as LUT-based logic, distrib-
uted and embedded memory, Phase Locked Loops (PLLs), Delay Locked Loops (DLLs), pre-engineered source 
synchronous I/O support, enhanced sysDSP slices and advanced configuration support, including encryption and 
dual-boot capabilities.

The pre-engineered source synchronous logic implemented in the LatticeECP3 device family supports a broad 
range of interface standards, including DDR3, XGMII and 7:1 LVDS.

The LatticeECP3 device family also features high speed SERDES with dedicated PCS functions. High jitter toler-
ance and low transmit jitter allow the SERDES plus PCS blocks to be configured to support an array of popular 
data protocols including PCI Express, SMPTE, Ethernet (XAUI, GbE, and SGMII) and CPRI. Transmit Pre-empha-
sis and Receive Equalization settings make the SERDES suitable for transmission and reception over various 
forms of media.

The LatticeECP3 devices also provide flexible, reliable and secure configuration options, such as dual-boot capa-
bility, bit-stream encryption, and TransFR field upgrade features.

The Lattice Diamond™ and ispLEVER® design software allows large complex designs to be efficiently imple-
mented using the LatticeECP3 FPGA family. Synthesis library support for LatticeECP3 is available for popular logic 
synthesis tools. Diamond and ispLEVER tools use the synthesis tool output along with the constraints from its floor 
planning tools to place and route the design in the LatticeECP3 device. The tools extract the timing from the routing 
and back-annotate it into the design for timing verification. 

Lattice provides many pre-engineered IP (Intellectual Property) modules for the LatticeECP3 family. By using these 
configurable soft core IPs as standardized blocks, designers are free to concentrate on the unique aspects of their 
design, increasing their productivity.
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Figure 2-2. PFU Diagram

Slice 
Slice 0 through Slice 2 contain two LUT4s feeding two registers, whereas Slice 3 contains two LUT4s only. For 
PFUs, Slice 0 through Slice 2 can be configured as distributed memory, a capability not available in the PFF. 
Table 2-1 shows the capability of the slices in both PFF and PFU blocks along with the operation modes they 
enable. In addition, each PFU contains logic that allows the LUTs to be combined to perform functions such as 
LUT5, LUT6, LUT7 and LUT8. There is control logic to perform set/reset functions (programmable as synchronous/
asynchronous), clock select, chip-select and wider RAM/ROM functions. 

Table 2-1. Resources and Modes Available per Slice

Figure 2-3 shows an overview of the internal logic of the slice. The registers in the slice can be configured for posi-
tive/negative and edge triggered or level sensitive clocks.

Slices 0, 1 and 2 have 14 input signals: 13 signals from routing and one from the carry-chain (from the adjacent 
slice or PFU). There are seven outputs: six to routing and one to carry-chain (to the adjacent PFU). Slice 3 has 10 
input signals from routing and four signals to routing. Table 2-2 lists the signals associated with Slice 0 to Slice 2.

Slice

PFU BLock PFF Block

Resources Modes Resources Modes

Slice 0 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 1 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 2 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 3 2 LUT4s Logic, ROM 2 LUT4s Logic, ROM

Slice 0

LUT4 &
CARRY

LUT4 &
CARRY

D D

Slice 1

LUT4 &
CARRY

LUT4 &
CARRY

Slice 2

LUT4 &
CARRY

LUT4 &
CARRY

From
 Routing

To
 Routing

Slice 3

LUT4 LUT4

D D D D

FF FF FF FF FF FF
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Modes of Operation
Each slice has up to four potential modes of operation: Logic, Ripple, RAM and ROM. 

Logic Mode
In this mode, the LUTs in each slice are configured as 4-input combinatorial lookup tables. A LUT4 can have 16 
possible input combinations. Any four input logic functions can be generated by programming this lookup table. 
Since there are two LUT4s per slice, a LUT5 can be constructed within one slice. Larger look-up tables such as 
LUT6, LUT7 and LUT8 can be constructed by concatenating other slices. Note LUT8 requires more than four 
slices.

Ripple Mode
Ripple mode supports the efficient implementation of small arithmetic functions. In ripple mode, the following func-
tions can be implemented by each slice: 

• Addition 2-bit 

• Subtraction 2-bit 

• Add/Subtract 2-bit using dynamic control 

• Up counter 2-bit 

• Down counter 2-bit

• Up/Down counter with asynchronous clear

• Up/Down counter with preload (sync) 

• Ripple mode multiplier building block

• Multiplier support 

• Comparator functions of A and B inputs
—  A greater-than-or-equal-to B
—  A not-equal-to B
—  A less-than-or-equal-to B

Ripple Mode includes an optional configuration that performs arithmetic using fast carry chain methods. In this con-
figuration (also referred to as CCU2 mode) two additional signals, Carry Generate and Carry Propagate, are gener-
ated on a per slice basis to allow fast arithmetic functions to be constructed by concatenating Slices.

RAM Mode
In this mode, a 16x4-bit distributed single port RAM (SPR) can be constructed using each LUT block in Slice 0 and 
Slice 1 as a 16x1-bit memory. Slice 2 is used to provide memory address and control signals. A 16x2-bit pseudo 
dual port RAM (PDPR) memory is created by using one Slice as the read-write port and the other companion slice 
as the read-only port.

LatticeECP3 devices support distributed memory initialization.

The Lattice design tools support the creation of a variety of different size memories. Where appropriate, the soft-
ware will construct these using distributed memory primitives that represent the capabilities of the PFU. Table 2-3 
shows the number of slices required to implement different distributed RAM primitives. For more information about 
using RAM in LatticeECP3 devices, please see TN1179, LatticeECP3 Memory Usage Guide.

Table 2-3. Number of Slices Required to Implement Distributed RAM 

SPR 16X4 PDPR 16X4

Number of slices 3 3

Note: SPR = Single Port RAM, PDPR = Pseudo Dual Port RAM

www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
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Figure 2-4. General Purpose PLL Diagram

Table 2-4 provides a description of the signals in the PLL blocks. 

Table 2-4. PLL Blocks Signal Descriptions

Delay Locked Loops (DLL)
In addition to PLLs, the LatticeECP3 family of devices has two DLLs per device. 

CLKI is the input frequency (generated either from the pin or routing) for the DLL. CLKI feeds into the output muxes 
block to bypass the DLL, directly to the DELAY CHAIN block and (directly or through divider circuit) to the reference 
input of the Phase Detector (PD) input mux. The reference signal for the PD can also be generated from the Delay 
Chain signals. The feedback input to the PD is generated from the CLKFB pin or from a tapped signal from the 
Delay chain. 

The PD produces a binary number proportional to the phase and frequency difference between the reference and 
feedback signals. Based on these inputs, the ALU determines the correct digital control codes to send to the delay 

Signal I/O Description 

CLKI I Clock input from external pin or routing 

CLKFB I PLL feedback input from CLKOP, CLKOS, or from a user clock (pin or logic) 

RST I “1” to reset PLL counters, VCO, charge pumps and M-dividers

RSTK I “1” to reset K-divider

WRDEL I DPA Fine Delay Adjust input

CLKOS O PLL output to clock tree (phase shifted/duty cycle changed) 

CLKOP O PLL output to clock tree (no phase shift) 

CLKOK O PLL output to clock tree through secondary clock divider 

CLKOK2 O PLL output to clock tree (CLKOP divided by 3)

LOCK O “1” indicates PLL LOCK to CLKI 

FDA [3:0] I Dynamic fine delay adjustment on CLKOS output

DRPAI[3:0] I Dynamic coarse phase shift, rising edge setting

DFPAI[3:0] I Dynamic coarse phase shift, falling edge setting 

CLKFB
Divider

RST

CLKFB

CLKI

LOCK

CLKOP

CLKOS

RSTK

WRDEL

FDA[3:0]

CLKOK2

CLKOK

CLKI
Divider

PFD VCO/
Loop Filter

CLKOP
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Duty Cycle/
Duty Trim

Duty Trim
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Detect

3
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Input signals are fed from the sysI/O buffer to the input register block (as signal DI). If desired, the input signal can 
bypass the register and delay elements and be used directly as a combinatorial signal (INDD), a clock (INCK) and, 
in selected blocks, the input to the DQS delay block. If an input delay is desired, designers can select either a fixed 
delay or a dynamic delay DEL[3:0]. The delay, if selected, reduces input register hold time requirements when 
using a global clock.

The input block allows three modes of operation. In single data rate (SDR) the data is registered with the system 
clock by one of the registers in the single data rate sync register block. 

In DDR mode, two registers are used to sample the data on the positive and negative edges of the modified DQS 
(ECLKDQSR) in the DDR Memory mode or ECLK signal when using DDR Generic mode, creating two data 
streams. Before entering the core, these two data streams are synchronized to the system clock to generate two 
data streams.

A gearbox function can be implemented in each of the input registers on the left and right sides. The gearbox func-
tion takes a double data rate signal applied to PIOA and converts it as four data streams, INA, IPA, INB and IPB. 
The two data streams from the first set of DDR registers are synchronized to the edge clock and then to the system 
clock before entering the core. Figure 2-30 provides further information on the use of the gearbox function.

The signal DDRCLKPOL controls the polarity of the clock used in the synchronization registers. It ensures ade-
quate timing when data is transferred to the system clock domain from the ECLKDQSR (DDR Memory Interface 
mode) or ECLK (DDR Generic mode). The DDRLAT signal is used to ensure the data transfer from the synchroni-
zation registers to the clock transfer and gearbox registers. 

The ECLKDQSR, DDRCLKPOL and DDRLAT signals are generated in the DQS Read Control Logic Block. See 
Figure 2-37 for an overview of the DQS read control logic.

Further discussion about using the DQS strobe in this module is discussed in the DDR Memory section of this data 
sheet.

Please see TN1180, LatticeECP3 High-Speed I/O Interface for more information on this topic.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32320
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SCI (SERDES Client Interface) Bus
The SERDES Client Interface (SCI) is an IP interface that allows the SERDES/PCS Quad block to be controlled by 
registers rather than the configuration memory cells. It is a simple register configuration interface that allows 
SERDES/PCS configuration without power cycling the device.

The Diamond and ispLEVER design tools support all modes of the PCS. Most modes are dedicated to applications 
associated with a specific industry standard data protocol. Other more general purpose modes allow users to 
define their own operation. With these tools, the user can define the mode for each quad in a design. 

Popular standards such as 10Gb Ethernet, x4 PCI Express and 4x Serial RapidIO can be implemented using IP 
(available through Lattice), a single quad (Four SERDES channels and PCS) and some additional logic from the 
core. 

The LatticeECP3 family also supports a wide range of primary and secondary protocols. Within the same quad, the 
LatticeECP3 family can support mixed protocols with semi-independent clocking as long as the required clock fre-
quencies are integer x1, x2, or x11 multiples of each other. Table 2-15 lists the allowable combination of primary 
and secondary protocol combinations. 

Flexible Quad SERDES Architecture
The LatticeECP3 family SERDES architecture is a quad-based architecture. For most SERDES settings and stan-
dards, the whole quad (consisting of four SERDES) is treated as a unit. This helps in silicon area savings, better 
utilization and overall lower cost.

However, for some specific standards, the LatticeECP3 quad architecture provides flexibility; more than one stan-
dard can be supported within the same quad.

Table 2-15 shows the standards can be mixed and matched within the same quad. In general, the SERDES stan-
dards whose nominal data rates are either the same or a defined subset of each other, can be supported within the 
same quad. In Table 2-15, the Primary Protocol column refers to the standard that determines the reference clock 
and PLL settings. The Secondary Protocol column shows the other standard that can be supported within the 
same quad.

Furthermore, Table 2-15 also implies that more than two standards in the same quad can be supported, as long as 
they conform to the data rate and reference clock requirements. For example, a quad may contain PCI Express 1.1, 
SGMII, Serial RapidIO Type I and Serial RapidIO Type II, all in the same quad.

Table 2-15. LatticeECP3 Primary and Secondary Protocol Support

Primary Protocol Secondary Protocol

PCI Express 1.1 SGMII

PCI Express 1.1 Gigabit Ethernet

PCI Express 1.1 Serial RapidIO Type I

PCI Express 1.1 Serial RapidIO Type II

Serial RapidIO Type I SGMII

Serial RapidIO Type I Gigabit Ethernet

Serial RapidIO Type II SGMII

Serial RapidIO Type II Gigabit Ethernet

Serial RapidIO Type II Serial RapidIO Type I

CPRI-3 CPRI-2 and CPRI-1

3G-SDI HD-SDI and SD-SDI
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Hot Socketing Specifications1, 2, 3

Hot Socketing Requirements1, 2

ESD Performance
Please refer to the LatticeECP3 Product Family Qualification Summary for complete qualification data, including 
ESD performance.

Symbol Parameter Condition Min. Typ. Max. Units

IDK_HS4 Input or I/O Leakage Current 0 VIN  VIH (Max.) — — +/–1 mA

IDK5 Input or I/O Leakage Current
0  VIN < VCCIO — — +/–1 mA

VCCIO  VIN  VCCIO + 0.5V — 18 — mA

1. VCC, VCCAUX and VCCIO should rise/fall monotonically.
2. IDK is additive to IPU, IPD or IBH. 
3. LVCMOS and LVTTL only.
4. Applicable to general purpose I/O pins located on the top and bottom sides of the device.
5. Applicable to general purpose I/O pins located on the left and right sides of the device.

Description Min. Typ. Max. Units

Input current per SERDES I/O pin when device is powered down and inputs 
driven. — — 8 mA

1. Assumes the device is powered down, all supplies grounded, both P and N inputs driven by CML driver with maximum allowed VCCOB 
(1.575 V), 8b10b data, internal AC coupling.

2. Each P and N input must have less than the specified maximum input current. For a 16-channel device, the total input current would be 8 mA*16 
channels *2 input pins per channel = 256 mA

http://www.latticesemi.com/dynamic/view_document.cfm?document_id=34723


3-11

DC and Switching Characteristics
LatticeECP3 Family Data Sheet

LVPECL33
The LatticeECP3 devices support the differential LVPECL standard. This standard is emulated using complemen-
tary LVCMOS outputs in conjunction with a parallel resistor across the driver outputs. The LVPECL input standard 
is supported by the LVDS differential input buffer. The scheme shown in Figure 3-3 is one possible solution for 
point-to-point signals.

Figure 3-3. Differential LVPECL33

Table 3-3. LVPECL33 DC Conditions1

Over Recommended Operating Conditions

Parameter Description Typical Units

VCCIO Output Driver Supply (+/–5%) 3.30 V

ZOUT Driver Impedance 10 

RS Driver Series Resistor (+/–1%) 93 

RP Driver Parallel Resistor (+/–1%) 196 

RT Receiver Termination (+/–1%) 100 

VOH Output High Voltage 2.05 V

VOL Output Low Voltage 1.25 V

VOD Output Differential Voltage 0.80 V

VCM Output Common Mode Voltage 1.65 V

ZBACK Back Impedance 100.5 

IDC DC Output Current 12.11 mA

1. For input buffer, see LVDS table.

Transmission line, 
Zo = 100 Ohm differential 

Off-chipOn-chip

VCCIO = 3.3 V 
(+/–5%)

VCCIO = 3.3 V 
(+/–5%)

RP = 196 Ohms 
(+/–1%)

RT = 100 Ohms 
(+/–1%)

RS = 93.1 Ohms 
(+/–1%)

RS = 93.1 Ohms 
(+/–1%)

16 mA

16 mA

+
–

Off-chip On-chip
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fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data Aligned at Pin (GDDRX1_TX.SCLK.Aligned)10 

tDIBGDDR Data Invalid Before Clock ECP3-150EA — 335 — 338 — 341 ps

tDIAGDDR Data Invalid After Clock ECP3-150EA — 335 — 338 — 341 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

tDIAGDDR Data Invalid After Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-35EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-35EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-17EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-17EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX1_TX.DQS.Centered)10 

Left and Right Sides

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 670 — 675 — 676 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 670 — 675 — 676 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX2_TX.Aligned)

Left and Right Sides

tDIBGDDR Data Invalid Before Clock All ECP3EA Devices — 200 — 210 — 220 ps

tDIAGDDR Data Invalid After Clock All ECP3EA Devices — 200 — 210 — 220 ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using DQSDLL (GDDRX2_TX.DQSDLL.Centered)11

Left and Right Sides 

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 400 — 400 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 400 — 400 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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LatticeECP3 Internal Switching Characteristics1, 2, 5 
Over Recommended Commercial Operating Conditions

Parameter Description

–8 –7 –6

Units.Min. Max. Min. Max. Min. Max.

PFU/PFF Logic Mode Timing

tLUT4_PFU LUT4 delay (A to D inputs to F output) — 0.147 — 0.163 — 0.179 ns

tLUT6_PFU LUT6 delay (A to D inputs to OFX output) — 0.281 — 0.335 — 0.379 ns

tLSR_PFU Set/Reset to output of PFU (Asynchronous) — 0.593 — 0.674 — 0.756 ns

tLSRREC_PFU
Asynchronous Set/Reset recovery time for 
PFU Logic 0.298 0.345 0.391 ns

tSUM_PFU Clock to Mux (M0,M1) Input Setup Time 0.134 — 0.144 — 0.153 — ns

tHM_PFU Clock to Mux (M0,M1) Input Hold Time –0.097 — –0.103 — –0.109 — ns

tSUD_PFU Clock to D input setup time 0.061 — 0.068 — 0.075 — ns

tHD_PFU Clock to D input hold time 0.019 — 0.013 — 0.015 — ns

tCK2Q_PFU 
Clock to Q delay, (D-type Register 
Configuration) — 0.243 — 0.273 — 0.303 ns

PFU Dual Port Memory Mode Timing

tCORAM_PFU Clock to Output (F Port) — 0.710 — 0.803 — 0.897 ns

tSUDATA_PFU Data Setup Time –0.137 — –0.155 — –0.174 — ns

tHDATA_PFU Data Hold Time 0.188 — 0.217 — 0.246 — ns

tSUADDR_PFU Address Setup Time –0.227 — –0.257 — –0.286 — ns

tHADDR_PFU Address Hold Time 0.240 — 0.275 — 0.310 — ns

tSUWREN_PFU Write/Read Enable Setup Time –0.055 — –0.055 — –0.063 — ns

tHWREN_PFU Write/Read Enable Hold Time 0.059 — 0.059 — 0.071 — ns

PIC Timing

PIO Input/Output Buffer Timing

tIN_PIO Input Buffer Delay (LVCMOS25) — 0.423 — 0.466 — 0.508 ns

tOUT_PIO Output Buffer Delay (LVCMOS25) — 1.241 — 1.301 — 1.361 ns

IOLOGIC Input/Output Timing

tSUI_PIO
Input Register Setup Time (Data Before 
Clock) 0.956 — 1.124 — 1.293 — ns

tHI_PIO Input Register Hold Time (Data after Clock) 0.225 — 0.184 — 0.240 — ns

tCOO_PIO Output Register Clock to Output Delay4 - 1.09 - 1.16 - 1.23 ns

tSUCE_PIO Input Register Clock Enable Setup Time 0.220 — 0.185 — 0.150 — ns

tHCE_PIO Input Register Clock Enable Hold Time –0.085 — –0.072 — –0.058 — ns

tSULSR_PIO Set/Reset Setup Time 0.117 — 0.103 — 0.088 — ns

tHLSR_PIO Set/Reset Hold Time –0.107 — –0.094 — –0.081 — ns

EBR Timing

tCO_EBR Clock (Read) to output from Address or Data — 2.78 — 2.89 — 2.99 ns

tCOO_EBR
Clock (Write) to output from EBR output 
Register — 0.31 — 0.32 — 0.33 ns

tSUDATA_EBR Setup Data to EBR Memory –0.218 — –0.227 — –0.237 — ns

tHDATA_EBR Hold Data to EBR Memory 0.249 — 0.257 — 0.265 — ns

tSUADDR_EBR Setup Address to EBR Memory –0.071 — –0.070 — –0.068 — ns

tHADDR_EBR Hold Address to EBR Memory 0.118 — 0.098 — 0.077 — ns

tSUWREN_EBR Setup Write/Read Enable to EBR Memory –0.107 — –0.106 — –0.106 — ns
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Figure 3-11. Write Through (SP Read/Write on Port A, Input Registers Only)

Note: Input data and address are registered at the positive edge of the clock and output data appears after the positive edge of the clock.

A0 A1 A0

D0 D1

D4

tSU

tACCESS tACCESS tACCESS

tH

D2 D3 D4

D0 D1 D2Data from Prev Read
or Write

Three consecutive writes to A0

D3DOA

DIA

ADA

WEA

CSA

CLKA

tACCESS
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PCI33 PCI, VCCIO = 3.3 V 66 MHz

1. These maximum speeds are characterized but not tested on every device.
2. Maximum I/O speed for differential output standards emulated with resistors depends on the layout.
3. LVCMOS timing is measured with the load specified in the Switching Test Conditions table of this document.
4. All speeds are measured at fast slew.
5. Actual system operation may vary depending on user logic implementation.
6. Maximum data rate equals 2 times the clock rate when utilizing DDR.

LatticeECP3 Maximum I/O Buffer Speed (Continued)1, 2, 3, 4, 5, 6

Over Recommended Operating Conditions

Buffer Description Max. Units
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SERDES High Speed Data Receiver 
Table 3-9. Serial Input Data Specifications

Input Data Jitter Tolerance
A receiver’s ability to tolerate incoming signal jitter is very dependent on jitter type. High speed serial interface stan-
dards have recognized the dependency on jitter type and have specifications to indicate tolerance levels for differ-
ent jitter types as they relate to specific protocols. Sinusoidal jitter is considered to be a worst case jitter type. 

Table 3-10. Receiver Total Jitter Tolerance Specification

Symbol Description Min. Typ. Max. Units

RX-CIDS
Stream of nontransitions1 
(CID = Consecutive Identical Digits) @ 10-12 BER

3.125 G — — 136

Bits 

2.5 G — — 144

1.485 G — — 160

622 M — — 204

270 M — — 228

150 M — — 296

VRX-DIFF-S Differential input sensitivity 150 — 1760 mV, p-p 

VRX-IN Input levels 0 — VCCA +0.54 V

VRX-CM-DC Input common mode range (DC coupled) 0.6 — VCCA V 

VRX-CM-AC Input common mode range (AC coupled)3 0.1 — VCCA +0.2 V

TRX-RELOCK SCDR re-lock time2 — 1000 — Bits

ZRX-TERM Input termination 50/75 Ohm/High Z –20% 50/75/HiZ +20% Ohms

RLRX-RL Return loss (without package) 10 — — dB

1. This is the number of bits allowed without a transition on the incoming data stream when using DC coupling.
2. This is the typical number of bit times to re-lock to a new phase or frequency within +/– 300 ppm, assuming 8b10b encoded data.
3. AC coupling is used to interface to LVPECL and LVDS. LVDS interfaces are found in laser drivers and Fibre Channel equipment. LVDS inter-

faces are generally found in 622 Mbps SERDES devices.
4. Up to 1.76 V.

Description Frequency Condition Min. Typ. Max. Units

Deterministic

3.125 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

2.5 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

1.25 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

622 Mbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Note: Values are measured with CJPAT, all channels operating, FPGA Logic active, I/Os around SERDES pins quiet, voltages are nominal, 
room temperature.
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Gigabit Ethernet/Serial Rapid I/O Type 1/SGMII/CPRI LV E.12 Electrical and 
Timing Characteristics
AC and DC Characteristics
Table 3-17. Transmit

Table 3-18. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.10 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.24 UI

1. Rise and fall times measured with board trace, connector and approximately 2.5 pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 1.25 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 1.25 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 1.25 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.34 UI

JRX_RJ
1, 2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.26 UI

JRX_SJ
1, 2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.11 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.71 UI

TRX_EYE Receiver eye opening 0.29 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 1.25 Gbps.
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sysI/O Differential Electrical Characteristics
Transition Reduced LVDS (TRLVDS DC Specification)

Over Recommended Operating Conditions

Mini LVDS
Over Recommended Operating Conditions

Symbol Description Min. Nom. Max. Units

VCCO Driver supply voltage (+/– 5%) 3.14 3.3 3.47 V

VID Input differential voltage 150 — 1200 mV

VICM Input common mode voltage 3 — 3.265 V

VCCO Termination supply voltage 3.14 3.3 3.47 V

RT Termination resistance (off-chip) 45 50 55 Ohms

Note: LatticeECP3 only supports the TRLVDS receiver.

Parameter Symbol Description Min. Typ. Max. Units

ZO Single-ended PCB trace impedance 30 50 75 Ohms

RT Differential termination resistance 50 100 150 Ohms

VOD Output voltage, differential, |VOP - VOM| 300 — 600 mV

VOS Output voltage, common mode, |VOP + VOM|/2 1 1.2 1.4 V

VOD Change in VOD, between H and L — — 50 mV

VID Change in VOS, between H and L — — 50 mV

VTHD Input voltage, differential, |VINP - VINM| 200 — 600 mV

VCM Input voltage, common mode, |VINP + VINM|/2 0.3+(VTHD/2) — 2.1-(VTHD/2)

TR, TF Output rise and fall times, 20% to 80% — — 550 ps

TODUTY Output clock duty cycle 40 — 60 %

Note: Data is for 6 mA differential current drive. Other differential driver current options are available.

Current 
Source

VCCO = 3.3 V

Z0

RT RTTransmitter

Receiver
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-17EA ECP3-35EA

Pin Type 256 ftBGA 328 csBGA 484 fpBGA 256 ftBGA 484 fpBGA 672 fpBGA

Emulated Differential I/O per 
Bank

Bank 0 13 10 18 13 21 24

Bank 1 7 5 12 7 18 18

Bank 2 2 2 4 1 8 8

Bank 3 4 2 13 5 20 19

Bank 6 5 1 13 6 22 20

Bank 7 6 9 10 6 11 13

Bank 8 12 12 12 12 12 12

Highspeed Differential I/O per 
Bank

Bank 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0

Bank 2 2 2 3 3 6 6

Bank 3 5 4 9 4 9 12

Bank 6 5 4 9 4 11 12

Bank 7 5 6 8 5 9 10

Bank 8 0 0 0 0 0 0

Total Single Ended/ Total 
Differential I/O per Bank

Bank 0 26/13 20/10 36/18 26/13 42/21 48/24

Bank 1 14/7 10/5 24/12 14/7 36/18 36/18

Bank 2 8/4 9/4 14/7 8/4 28/14 28/14

Bank 3 18/9 12/6 44/22 18/9 58/29 63/31

Bank 6 20/10 11/5 44/22 20/10 67/33 65/32

Bank 7 23/11 30/15 36/18 23/11 40/20 46/23

Bank 8 24/12 24/12 24/12 24/12 24/12 24/12

DDR Groups Bonded per 
Bank2

Bank 0 2 1 3 2 3 4

Bank 1 1 0 2 1 3 3

Bank 2 0 0 1 0 2 2

Bank 3 1 0 3 1 3 4

Bank 6 1 0 3 1 4 4

Bank 7 1 2 2 1 3 3

Configuration 
Bank 8 0 0 0 0 0 0

SERDES Quads 1 1 1 1 1 1

1. These pins must remain floating on the board.
2. Some DQS groups may not support DQS-12. Refer to the device pinout (.csv) file.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-70EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-6FN1156C 1.2 V –6 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-7FN1156C 1.2 V –7 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-8FN1156C 1.2 V –8 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-6LFN1156C 1.2 V –6 LOW Lead-Free fpBGA 1156 COM 67

LFE3-70EA-7LFN1156C 1.2 V –7 LOW Lead-Free fpBGA 1156 COM 67

LFE3-70EA-8LFN1156C 1.2 V –8 LOW Lead-Free fpBGA 1156 COM 67

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-95EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-6FN1156C 1.2 V –6 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-7FN1156C 1.2 V –7 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-8FN1156C 1.2 V –8 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-6LFN1156C 1.2 V –6 LOW Lead-Free fpBGA 1156 COM 92

LFE3-95EA-7LFN1156C 1.2 V –7 LOW Lead-Free fpBGA 1156 COM 92

LFE3-95EA-8LFN1156C 1.2 V –8 LOW Lead-Free fpBGA 1156 COM 92

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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Industrial

The following devices may have associated errata. Specific devices with associated errata will be notated with a 
footnote.

Part Number Voltage Grade Power Package1 Pins Temp. LUTs (K) 

LFE3-17EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-6MG328I 1.2 V –6 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-7MG328I 1.2 V –7 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-8MG328I 1.2 V –8 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-6LMG328I 1.2 V –6 LOW Green csBGA 328 IND 17

LFE3-17EA-7LMG328I 1.2 V –7 LOW Green csBGA 328 IND 17

LFE3-17EA-8LMG328I 1.2 V –8 LOW Green csBGA 328 IND 17

LFE3-17EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 17

1. Green = Halogen free and lead free.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-35EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 33

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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Updated Simplified Channel Block Diagram for SERDES/PCS Block 
diagram.

Updated Device Configuration text section.

Corrected software default value of MCCLK to be 2.5 MHz.

DC and Switching 
Characteristics

Updated VCCOB Min/Max data in Recommended Operating Conditions 
table.

Corrected footnote 2 in sysIO Recommended Operating Conditions 
table.

Added added footnote 7 for tSKEW_PRIB to External Switching Charac-
teristics table. 

Added 2-to-1 Gearing text section and table.

Updated External Reference Clock Specification (refclkp/refclkn) table.

LatticeECP3 sysCONFIG Port Timing Specifications - updated tDINIT 
information.

Added sysCONFIG Port Timing waveform.

Serial Input Data Specifications table, delete Typ data for VRX-DIFF-S.

Added footnote 4 to sysCLOCK PLL Timing table for tPFD.

Added SERDES/PCS Block Latency Breakdown table.

External Reference Clock Specifications table, added footnote 4, add 
symbol name vREF-IN-DIFF.

Added SERDES External Reference Clock Waveforms.

Updated Serial Output Timing and Levels table.

Pin-to-pin performance table, changed "typically 3% slower" to "typically 
slower".

Updated timing information

Updated SERDES minimum frequency.

Added data to the following tables: External Switching Characteristics, 
Internal Switching Characteristics, Family Timing Adders, Maximum I/O 
Buffer Speed, DLL Timing, High Speed Data Transmitter, Channel Out-
put Jitter, Typical Building Block Function Performance, Register-to-
Register Performance, and Power Supply Requirements.

Updated Serial Input Data Specifications table.

Updated Transmit table, Serial Rapid I/O Type 2 Electrical and Timing 
Characteristics section.

Pinout Information Updated Signal Description tables.

Updated Pin Information Summary tables and added footnote 1.

February 2009 01.0 — Initial release.

Date Version Section Change Summary


